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1About CentreWare® 
Printer Drivers for 
Microsoft Windows

CentreWare is software that brings the power of your Xerox systems to your desktop. The 
interactive drivers in CentreWare make printing and faxing from the desktop simple to perform 
and easy to understand.

With this guide, administrators can install and configure CentreWare printer drivers and general 
users can increase their productivity using the Xerox system’s printing options.

What’s in this chapter:
• Printer and Fax Driver Overview 1-2
• Types of CentreWare Printer Drivers 1-3
• Obtaining CentreWare Drivers 1-3
• Xerox System PPD Files 1-3
• CentreWare Printer Driver Applications 1-4
• Print and Fax Driver Documentation 1-5
• Internet Support 1-6
• Telephone Support 1-6
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Printer and Fax Driver Overview
A printer driver makes documents created with specialized software applications (word 
processing, spreadsheets, graphics) compatible with a specific printer. Each type of printer 
requires unique commands to print correctly and to enable special features. For these reasons, 
different types of printers require their own printer drivers to operate correctly. 

With CentreWare printer drivers, you can print from your workstation to a Xerox system in a 
network environment. CentreWare drivers contain a variety of feature options that you can use 
to customize your print jobs. 

Some printer drivers also support faxing. Integrated fax capabilities vary with each Xerox 
system. Not all Xerox printers support both network printing and ax submitted from the 
desktop. Check your product-specific literature for more details. Other network fax options can 
be configured with different models, using third-party software applications.
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Types of CentreWare Printer Drivers
The CentreWare printer drivers are available in PostScript 3, PCL 5c, and PCL 6c printing formats.

PostScript

PostScript gives you greater ability to scale and manipulate images; it offers more precision 
with
high-end graphics. PostScript also provides you with different types of error-handling and font 
substitution options. 

PCL

PCL (Printer Command Language) generally has fewer advanced features than PostScript. 
However, using PCL enables you to process most jobs faster.

Obtaining CentreWare Drivers

CentreWare Print and Fax Services Disc

The installation .inf files for the Xerox system printer drivers are available in the Drivers folder on 
the CentreWare Print and Fax Drivers Disc. 

Note
Driver availability may vary by printer model or operating system.

For updates and additional information, visit the Xerox Web site.

Downloading from the Web

CentreWare printer drivers can be downloaded from the Xerox Web site at www.xerox.com. The 
installation files for all Xerox system models are also available from the Web site.

For more information on downloading drivers, see Downloading the Xerox Print Driver on page 
2-3.

Xerox System PPD Files

A PostScript Printer Description (PPD) file is a readable text file that provides a uniform 
approach to specifying special features for printer drivers that interpret PostScript. 

Xerox provides PostScript PPDs for use with generic Windows XP / Vista / Windows 7 PostScript 
printer drivers. These PPDs are available on the CentreWare Disc or from the Xerox Web site.

http://www.xerox.com
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CentreWare Printer Driver Applications
The following applications are included on the CentreWare Print and Fax Drivers Disc:

• Xerox Print Driver Installation utility
• Xerox Font Management Utility

Xerox Printer Driver Installation Utility

This utility is for anyone who would like to install printer drivers directly onto a PC or network 
server. 

Note
You may require administrator rights to perform the installation.

Xerox Font Management Utility

The Xerox Font Management Utility is a tool used for managing fonts and printer lists. Fonts 
may be viewed, printed, or downloaded to printers, and your downloaded (non-resident) fonts 
can be exported to a file. Printers can be added or deleted from a printer list which is used for 
adding and deleting fonts from one or multiple printers. 

See “Installing the Xerox Font Management Utility” on page 4-1. for more information.

Xerox Scan Utility

The Xerox Scan Utility enables you to control and manage image files scanned to your 
computer. 

See “Xerox Desktop Scanning” on page 5-1. for more information.
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Print and Fax Driver Documentation
The CentreWare printer drivers include the following documentation, designed to get you up 
and running quickly and easily. 

CentreWare Printer Drivers Guide for Windows (This guide)

This guide is intended for anyone who installs and configures CentreWare printer drivers and 
wants to know more about the features available in the printer drivers.

The CentreWare Printer Drivers Guide is available on the CentreWare Print and Fax Drivers Disc 
in electronic (PDF) format. You can download a free Adobe Acrobat Reader from Adobe at 
www.adobe.com.

Help

The Help system is the primary source for information about using the printer drivers. You can 
access the Help system through the Help buttons in the driver. Included in the Help system are 
feature descriptions, step-by-step procedures, Xerox system information, problem-solving 
information, and support information. 

www.adobe.com/products/acrobat/readstep2.html
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Support
Support for your CentreWare printer drivers is available both online and by telephone.

Internet Support

Please visit the Xerox Web site (www.xerox.com) for product support information, product 
overviews, updates, and links to specific product sites. Printer drivers and PPDs can also be 
downloaded by clicking Support & Drivers. 

Telephone Support

For additional assistance, you may contact the Xerox Welcome Center by telephone to speak 
with a Product Support Analyst. Locate your Xerox system serial number, and record it in the 
space below before you make your call.

The Xerox Welcome Center telephone numbers are listed in the following table. If the Welcome 
Center telephone number for your country is not listed, it will be provided to you when your 
Xerox system is installed. For future reference, please record the telephone number in the space 
provided below. 

Additional Tips

Additional tips and technical information for printer drivers are available at the Xerox Web site. 
Click Support & Drivers, identify your product, and click the Documentation link. The documents 
listed in this section cover specific issues that may require special procedures or application 
notes regarding the operation and configuration of your Xerox system. 

Xerox System Serial Number:

Welcome Center Telephone Numbers:

UNITED STATES 800-821-2797

UNITED STATES (TTY) 800-855-2880

CANADA 800-939-3769 (800-93-XEROX)

OTHER

http://www.xerox.com
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2Installing Windows 
Printer Drivers

The CentreWare printer drivers support the special features and functions of Xerox systems, 
enabling fast, efficient printing from your desktop. This chapter provides installation 
instructions for all current Windows environments.

What’s in this chapter:
• Supported Printing Environments 2-2
• Installation Overview 2-3
• Installation Using the Xerox Installer 2-3
• Installation Using the Add Printer Wizard 2-4
• Installation Using Point and Print 2-6
• Installation on Terminal or Citrix Server 2-7
• Installation on a Cluster Server 2-7
• Installation in Novell® Netware Environment 2-8
• Uninstalling 2-8
• Uninstalling 2-8
• Configuring Printer Drivers 2-9
• About Bi-Directional Printer Drivers 2-11
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Supported Printing Environments

Available Drivers 

A driver is available for download in each of the following Printer Description Languages (PDL): 

• Windows PostScript (level 2 & 3) 
• Windows PCL 5c
• Windows PCL 6 

Supported Operating Systems

Printing Environments

Windows XP 32-bit: 
XP Home and Professional, Terminal Server, Citrix XP Server, Cluster Server 

Windows XP 64-bit: 
Windows XP Professional 64-bit editions 

Windows Vista 32- and 64-bit: 
Vista Home Basic, Home Premium, Business, Ultimate

Windows 7 32- and 64-bit: 
Home Premium, Professional, Ultimate, Enterprise

Novell Netware 5.x: 
NDS 

Novell Netware 6.x:
NDS, iPrint 

Internet Printing Protocol (IPP): 
Microsoft RDP and HTTP 

Citrix Server: 
Meta Frame FR3, Presentation Server 4.x
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Installation Overview 
The Xerox Print Driver can be installed using one of the following methods: 

• Xerox Installer 
• Add Printer Wizard provided by the operating system 
• Point and Print 

Note
The Xerox installer method does not support Citrix Server, Terminal Server, Cluster Server, 
Novell Netware environments. 

The driver relies on SNMP communication to detect device capabilities and perform status 
reporting. The Xerox Print Driver allows users to customize the features of print queues installed 
using the driver. When bi-directional communication does not function, or when SNMP is 
disabled in an environment, you can modify the default configuration of the print queue.

Downloading the Xerox Print Driver

To download the Xerox Print Driver installer without using the installer:
1. Using a web browser, go to www.xerox.com.
2. Click Support & Drivers.
3. Identify your product.
4. Click Drivers and Downloads under the printer model.
5. Choose the desired operating system and language, then click Go. The available driver 

options are updated.
6. From the list of drivers, click the appropriate driver to download.
7. Read the End-User License Agreement and click Accept.
8. Save the installer and note the location where it is saved.

Installation Using the Xerox Installer 
1. Double-click the Setup.exe file to launch the Xerox Installer. 
2. Select I Agree to accept the Xerox License Agreement.
3. The installer automatically searches the network for printers. Select a device from the list of 

discovered printers. 
a. Select Extended Search or Advanced Search if the printer is not dynamically 

discovered by the installer. 
b. Select the IP Address or DNS Name button to enter the IP Address or DNS Name.
c. Select Search and then select the Device. You may select View to change the sort order 

of any discovered printers.

Tip
Type the first few letters of the name of the desired printer, IP address, or other printer 
information in the Discovered Printers box to filter the printers in the list.



Installing Windows Printer Drivers Xerox® Printer Drivers

2-4  Printer Drivers Guide for Windows

Note
Examples of printers that may not appear on the discovered printers list or search results, 
regardless of operating system, include printers connected to a different subnet or printers 
on a print queue.

Using the discovered printers list, IP address, or DNS name to identify the printer results in 
the creation of a local print queue.

4.  Click Options and then: 
a. Select the language for the print driver.
b. Select the page description language desired from the Print Driver Selection area. 
c. Select the scan driver you want to install (if any). See the note on page 5-3 about 

installing both the WIA and TWAIN drivers on the same computer.
d. Click OK.

5. Click Install.
6. Select if you want to use the printer as the default printer and if you want to print a test 

page. Click Finish.

Installation Using the Add Printer Wizard 

Windows XP
1. Double-click the .exe file to open the Xerox Print Driver dialog box.
2. Click Install. The driver will extract.
3. The Add Printer Wizard dialog box appears. Click Next. 
4. The Local or Network Printer dialog box appears. Select Local Printer > Next.
5. The Select a Printer Port dialog box appears. Select Create a new port > Standard TCP/IP 

Port > Next. 
6. The Add Standard TCP/IP Printer Port Wizard dialog box appears. Click Next.
7. The Add Port screen appears. Type the printer name or IP address. Click Next.

Note
If you enter an invalid IP address or device discover fails, the Select Printer Configuration 
dialog appears and enables you to choose the correct driver to install from the list of 
supported printers.

To connect to a printer on an IPv6 network, the IPv6 protocol must be installed on your 
computer.

By default, Microsoft does not support printing over IPv6 on Windows XP.

8. Click Finish. The wizard closes. 
9. Select Have Disk from the Manufacturer/Printers window. 
10. Click Browse and select the .inf file for your printer. 
11. Click Open > OK. 
12. Select the printer from the list. Click Next.
13. Type the printer name and select if you want to use the printer as the default printer. Click 

Next. 
14. Select if you want to share the printer. Click Next. 
15. Select if you want to print a test page. Click Next.
16. Click Finish
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Windows Vista 
1. Double-click the .exe file to open the Xerox Print Driver dialog box.
2. Click Run at the Security Warning.
3. Click Install. The driver will extract and the Choose a local or network printer dialog box 

appears.
4. Choose Add a local printer. The Choose a printer port dialog box appears.
5. Select Create a new port > Standard TCP/IP Port > Next. 
6. The Type a printer hostname or IP address dialog box appears. Choose TCP/IP Device 

from the Device type drop down menu
7. Type the hostname or IP address. Clear the Query the printer checkbox. Click Next. 
8. If you receive the Additional Port Information Required box, click Next.
9. Select Have Disk from the Manufacturer/Printers window. 
10. Click Browse and select the .inf file for your printer. 
11. Click Open > OK. 
12. Select the printer from the list. Click Next.
13. Type the printer name and select if you want to use the printer as the default printer. Click 

Next. 
14. Select if you want to share the printer. Click Next. 
15. Select if you want to print a test page. Click Next. 
16. Click Finish.

Windows 7 
1. Click Start > Devices and Printers.
2. Select Add a Printer.
3. Select Add a local printer.
4. The Choose a printer port dialog box appears.
5. Select Create a new port > Standard TCP/IP Port > Next.
6. The Type a printer hostname or IP address dialog box appears.
7. Choose TCP/IP Device in the Device type menu.
8. Enter the hostname or IP address.
9. Clear the Query the printer checkbox. Select Next.
10. If you receive the Additional Port Information Required box, select Next.
11. Select Have Disk from the Manufacturer/Printers window.
12. Press Browse and select the printer's .inf file.
13. Press Open > OK.
14. Select the printer from the list. Select Next.
15. Enter the printer name.
16. Select if you want to use the printer as the default printer. Click Next.
17. Select if you want to print a test page.Click Next.
18. Select Finish.



Installing Windows Printer Drivers Xerox® Printer Drivers

2-6  Printer Drivers Guide for Windows

Installation Using Point and Print 

Follow the Installation Using the Add Printer Wizard instructions on page 4 to install the 
appropriate Xerox printer driver on a network server to prepare for Point and Print 

The following procedure assumes that a Xerox system on a network server has been installed 
with the appropriate Xerox printer driver prior to performing Point and Print.

1. At the client workstation, access the desired print server using information provided by your 
IT department.

2. Select the print queue from the print server.
3. Do one of the following:

• Right-click the printer icon and select Connect.
• Click the printer icon. Drag and drop the printer icon on the Printers folder.

Note
If you receive a message asking if you want to continue, select Yes.

You can change a printer to shared status by right-clicking the printer icon, selecting 
Sharing, and filling in the Share name on the Sharing tab.
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Installation on Terminal or Citrix Server

A Citrix server can be configured to “auto-create” a printer or printers when a Windows client 
logs in. This procedure makes the client’s Windows printers available within a Citrix session. If 
the appropriate drivers do not reside on the Citrix server, the Citrix server substitutes a universal 
driver. The user can still print, but many of the features associated with printer drivers, such as 
accounting or booklet creation, are unavailable.

To prevent this, install the Xerox drivers on a Citrix server (or on all members of a Citrix server 
farm) before clients that use local printers based on these drivers log in.

Note
The driver name (string) on the clients must match up with the driver name (string) on the 
Citrix server in order for the printer driver to auto-create correctly during a Citrix session. If 
they do not match, the user will get a universal driver with limited features.

For more information, see the Citrix white paper, available online at

http://www.citrix.com/site/resources/dynamic/salesdocs/
PresentationServer4.0PrintingEnhancementsWhitepaper04OCT2005.pdf.

Installation on a Cluster Server 

Clustering is a technology that configures two or more servers, or nodes, to behave as one. Each 
node has access to a storage medium, known as the cluster, which houses the supported 
application or data. 

When a cluster houses a print server, only the print spooler folder resides on the cluster. The 
printer drivers reside on the nodes in their standard locations. When one node fails, printing 
continues using the drivers that are present on a surviving node. Should that node lack the 
appropriate drivers, consequences range from a lack of access to advanced driver features to a 
complete inability to print.

The Xerox print driver must be installed on each node prior to being installed on the client. Use 
the Add Printer Driver Wizard to install the printer drivers in a cluster. For details on configuring 
the printer in a Cluster environment, see the Microsoft® white paper, available online at http://
support.microsoft.com/kb/278455.

http://www.citrix.com/site/resources/dynamic/salesdocs/PresentationServer4.0PrintingEnhancementsWhitepaper04OCT2005.pdf
http://www.citrix.com/site/resources/dynamic/salesdocs/PresentationServer4.0PrintingEnhancementsWhitepaper04OCT2005.pdf
http://support.microsoft.com/kb/278455
http://support.microsoft.com/kb/278455
http://support.microsoft.com/kb/278455
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Installation in Novell® Netware Environment 

NDS

To print in a Novell® Netware environment, NetWare Directory Services (NDS) must be 
activated on the printer.

1. Open a web browser and enter the TCP/IP address of the machine in the Address or 
Location field and click Enter.

2. Select the Properties tab.
3. Select the + symbol to the left of Security.
4. Select Authentication Configuration.
5. If prompted, enter the Administrator User name and Password to gain access to 

Authentication Configuration.
6. Type a directory tree and context for the machine in NDS Tree and NDS Context in the 

Netware Directory Services (NDS) box. Note that you can also select the IP Address or Host 
Name radio buttons to specify the server used in the IP environment.

7. Click Apply to accept the changes or Undo to return the settings to their previous values. 

Note
The settings are not applied until you reboot the machine.

8. Select the Status Tab link.
9. Click the Reboot Machine button then OK to reboot the machine. The network controller 

takes approximately 5 minutes to reboot and network connectivity will be unavailable 
during this time.

Novell Netware 6.x iPrint

For details on configuring iPrint, see the white paper, available online at http://www.novell.com/
products/netware/printing/quicklook.html.

To ensure proper function of the automatic configuration capabilities of the installer, the Novell 
iPirnt client, version 4.20 or above, must be installed on the clients connecting to the iPrint 
queues.

Uninstalling
 To uninstall the Xerox printer driver:
1. Using the appropriate path for your operating system, locate the list of printers:

• Windows XP: Start > Printers and Faxes
• Windows Vista/Windows 7: Start > Control Panel > Hardware and Sound > Printers
The Printers or Printers and Faxes or Devices and Printers window appears.

2. Right-click on the icon for the printer you want to delete and select Delete or Remove 
Device. A confirmation message appears.

3. Click Yes to delete the printer driver.
4. Repeat steps 2 and 3 for all printer objects that use the driver being uninstalled.

http://www.novell.com/products/netware/printing/quicklook.html
http://www.novell.com/products/netware/printing/quicklook.html
http://www.novell.com/products/netware/printing/quicklook.html
http://www.novell.com/products/netware/printing/quicklook.html
http://www.novell.com/products/netware/printing/quicklook.html
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For Windows XP only:
1. Right-click in the blank area of the folder or choose File. A menu opens.
2. Select Server Properties. A Print Server Properties dialog box appears.
3. Select the Drivers tab.
4. Select the printer driver to delete.
5. Click the Remove button. The printer driver is deleted.
6. Reboot the workstation.

Configuring Printer Drivers
To use the CentreWare printer drivers most effectively, configure the drivers to reflect options 
available on the Xerox system. You can configure the drivers in one of the following ways:

• Preconfigure standard device and document settings in the driver prior to distributing them 
for installation

• Configure installable options directly on the workstation

Preconfiguring Settings in the Driver

You can preconfigure settings in the print driver so that when users install the print driver, 
desired settings are already enabled for them such as duplex printing or stapling. See the 
Preconfiguring the Xerox User Interface Print Drivers document located at http://
www.office.xerox.com/support/dctips/dc04cc0328.pdf for more information.

Configuring Installable Options at the Workstation

You may want to configure installable options directly at a workstation. You may be able to 
configure the driver settings automatically, using the Bi-Directional communication 
functionality of the driver, or make the selections manually, setting the options on the 
individual driver dialogs.

Note
If you want the print driver to identify your installable options, the Bi-Directional feature 
must be on. Bi-Directional is on by default.

Configuring Installable Options Automatically

If you have a TCP/IP network, the Windows printer drivers can provide Bi-Directional 
capabilities. The printer driver communicates with the printer through your network and 

http://www.office.xerox.com/support/dctips/dc04cc0328.pdf 
http://www.office.xerox.com/support/dctips/dc04cc0328.pdf 
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acquires information from the printer. Use the following procedure to ensure that Bi-Directional 
support is active.

1. Using the appropriate path for your operating system, locate the list of printers:
• Windows XP: Start > Printers and Faxes
• Windows Vista/Windows 7: Start > Control Panel > Hardware and Sound > Printers

2. Right-click on the desired printer and select Properties.
3. Select the Configuration tab.
4. Click the Bi-Directional Setup button.
5. Ensure that either Automatic (Recommended) or Manual are selected. If Automatic is 

selected, the port that was used to install the printer is used for Bi-Directional 
communication. If Manual is selected you can type the Device Name or TCP/IP Address for 
the desired printer.

6. Click OK twice to save the Installable Options settings and close the Properties dialog.
7. Close the Printers or Printers and Faxes window.

Configuring Installable Options Manually

If your network environment does not support Bi-Directional communication, you can configure 
installable options manually.

1. Using the appropriate path for your operating system, locate the list of printers:
• Windows XP: Start > Printers and Faxes
• Windows Vista/Windows 7: Start > Control Panel > Hardware and Sound > Printers

2. Right-click on the desired printer and select Properties.
3. Select the Configuration tab.
4. Click the Bi-Directional Setup button.
5. Click the Off option button.
6. Click OK.
7. Click Apply.
8. Click Installable Options and select the options that are available on your Xerox system.
9. Click OK twice to save the Installable Options settings and close the Properties dialog.
10. Close the Printers or Printers and Faxes window.
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About Bi-Directional Printer Drivers
With Bi-Directional communication, a printer driver communicates with the printer through the 
network. The Windows printer drivers can provide Bi-Directional capabilities for TCP/IP 
networks. 

After an initial setup procedure, Bi-Directional communication automatically updates the 
printer driver with the installed options available on the printer and reports specific information 
about the operational status, active jobs, completed jobs, and paper status in your Xerox 
system. 

Note
If network communication is temporarily unavailable or is not configured properly for the 
printer, the network, or your workstation, the Bi-Directional information does not appear

Status Dialog

The Status dialog shows the status of the Xerox system as well as specific information about its 
print jobs. Check the status of up to 25 jobs currently in the print queue or verify the status of 
completed jobs. Use this dialog to check the properties of the paper loaded in different paper 
trays on your printer and also the current paper levels in those trays. You can also use this dialog 
to verify that your printer is functioning properly.

Click More Status on the bottom of any tab window to access the Status dialog. 

The data available in server-based drivers will not update on a regular basis. When 
configuration changes are made, the driver must be reopened to detect the changes.
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3Printer Driver 
Features

With the CentreWare printer drivers, you have an invaluable tool to save time and increase your 
productivity. These drivers offer over thirty-five feature options, depending on the type of driver 
and the installable finisher options, for you to choose how your document will look and print. 

The Help system is the primary source for information about using the printer drivers. At any 
time, you can access the Help system through the Help buttons on the driver.

What’s in this chapter:
• Driver Structure 3-2
• Driver Tabs 3-3
• Driver Help System 3-4
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Driver Structure
The driver arranges the features on the following tabs: Paper/Output, Special Pages, Color 
Options, Image Options, Layout/Watermark, and Advanced.  

The features on the tabs are organized for your convenience with the most frequently used 
features available when you open the driver. Small icons are placed next to the features so that 
you can quickly find the features you want. By clicking on the icon you can go through the list of 
options for that feature. Or, use the drop down list to see the options.

When chosen, certain features constrain other features. For example, if you set Finishing 
to Booklet Fold, Booklet Layout, an information icon on the printer driver near the 2 
Sided Printing option appears, and 2 Sided Print, Flip on Short Edge displays in gray. 

When you click the information icon, a pop-up dialog appears explaining why the feature is not 
available or why it is constrained to a particular selection, as in this case, booklet printing 
requires 2 Sided Print, Flip on Short Edge.
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Driver Tabs
Features vary on the driver tabs depending on the driver type and installable options.

General Tabs

These driver tabs are accessed through the application’s print dialog. Driver setting changes on 
these tabs apply to the open document and application, and are temporary. Depending on your 
printer, you may have either the Color Options tab or the Image Options tab.

Paper/Output

The Paper/Output tab has the most frequently used features. For example, you can choose to 
print on two sides of the paper, select specific media on which to print, or delay your print job to 
a time you specify. The Paper/Output tab also presents the finishing options, which may include 
Staple, Fold, Hole Punch, or post-process insertion options, depending on the type of finisher 
you have installed.

Special Pages

The Special Pages tab has features for adding Covers, Inserts, and Exceptions (specifying media 
/ page characteristics on a per-page basis).

Color Options

The Color Options tab, if available, groups together features that are related to color correction 
and color adjustments.

Image Options

The Image Options dialog, if available, adjusts the overall lightness or darkness of the text and 
images in your printed documents.

Layout/Watermark

The Layout/Watermark tab contains all features that relate to Page Layout and Watermarks. 
The Watermark Editor, which is accessed from the Watermark dialog, enables you to create and 
customize text or graphic watermarks.

Advanced

The Advanced tab contains features that infrequently change once the options are set, such as 
Banner Sheet, Request Offset, TrueType Font options, Booklet Layout, and Image Options.

Status

If you have enabled the optional Bi-Directional communication for a printer driver, a Status 
area is added to the bottom of all tab windows. When you click More Status, the Status dialog 
opens and reports specific information about the printer’s operational status as well as specific 
information about your print jobs. See “Status Dialog” on page 2-11.
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Default Tabs

These driver tabs are accessed through the Printers folder and may be available only with 
administrative rights. Using the appropriate path for your operating system, locate the list of 
printers:

• Windows XP - Start > Control Panel >Printers & Faxes
• Windows Vista/Windows 7 - Start button > Control Panel > Hardware and Sound > 

Printers 

The Printers or Printers and Faxes window appears. Right-click on the printer icon and select 
Properties from the menu. The printer driver dialog appears. Driver settings from this dialog 
become the default settings. All of the General Tabs from your application’s print dialog are 
available, as well as some other tabs such as the Configuration tab and the Device Settings tab.

The Configuration dialog contains several buttons (depending on your Xerox system model): Bi-
Directional Setup, Installable Options, Accounting and About. Each button opens a dialog to 
configure your driver. 

• Bi-Directional Communication allows you to enable bi-directional communication. You will 
then receive information through the driver about your print job, Xerox system, and paper 
status. See “About Bi-Directional Printer Drivers” on page 2-11.

• Installable Options lets you manually configure the driver with the number of paper trays 
and installable options - such as finishers and faxing - available on your Xerox system. 

• Accounting lets you set up the driver to use accounting features. See the Accounting topic 
in the printer driver Help for more information.

• About shows the driver version number. Xerox personnel may request this number during 
support calls.

The Device Settings tab contains features that relate to font settings and PostScript settings.

Driver Help System
The Help system is the primary source for information about using the printer drivers. Each 
driver tab has a Help button for easy access to the Help system. Through this Help button you 
can call up information on any feature on that tab or any other tab. Among the useful items in 
the Help system is a menu of How To... procedures for each feature, for example, How to print 
booklets, turn banner sheets on/off, print transparencies, or track printer use by account.
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4Installing the Xerox 
Font Management 
Utility 

The Xerox Font Management Utility is a tool used to maintain fonts on network printers. Font 
lists can be developed and modified for your printers. For example, if you have special fonts that 
are used in documents but are not readily available on your printer(s), use the Xerox Font 
Management Utility to download the required fonts to the printers. Using the utility, fonts may 
be viewed, printed, downloaded to printers, or your downloaded (non-resident) fonts exported 
to a file. You may also maintain printer lists for font management.   

What’s in this chapter:
• Installing the Xerox Font Management Utility 4-2
• Accessing the Xerox Font Management Utility 4-2
• Using the Xerox Font Management Utility 4-2
• Uninstalling the Xerox Font Management Utility 4-3
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Installing the Xerox Font Management 
Utility
To install the utility:
1. Insert the CentreWare Print and Fax Drivers Disc into the appropriate drive. The AutoRun 

program starts.
2. Click Tools and Utilities.
3. Click Install Font Management Utility.
4. The installation wizard opens. Click Next.
5. Select the radio button to accept the license agreement. Click Next.
6. Type the user name and organization. 
7. Specify who has access to the application. Click Next.
8. Select the Setup type: Complete or Custom. Click Next.
9. Click Install to install the utility on the workstation.
10. Click Finish to exit the install wizard.   

The installation is complete.

Accessing the Xerox Font Management 
Utility
To access the utility in Windows environments:

From the desktop, select Start > All Programs > Xerox Font Management Utility > Font 
Management Utility in Windows XP / Vista / Windows 7.

Using the Xerox Font Management 
Utility
The Help system is the primary source for information about using the Xerox Font Management 
Utility. You can access the Help system through the Help buttons. Included in the Help system 
are feature descriptions and step-by-step procedures. 
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Uninstalling the Xerox Font 
Management Utility
To uninstall the Xerox Font Management Utility, use the Add/Remove Programs wizard in the 
Control Panel folder. If you have access to the CentreWare Print and Fax Drivers Disc, you can 
modify and/or repair the Xerox Font Management Utility.

To uninstall the utility:
1. Using the appropriate path for your operating system, locate the list of printers:

• Windows XP - Start > Control Panel > Add or Remove Programs 
• Windows Vista / Windows 7 - Start button > Control Panel > Programs > Programs and 

Features > Uninstall a program 
The dialog for installing, changing, or uninstalling programs opens.

2. Select Xerox Font Management Utility.
3. Follow the procedures in the wizard to remove the Xerox Font Management Utility from 

your system.

To repair the utility:

With this option, you can fix missing or corrupt files, shortcuts, and registry entries.

1. Insert the CentreWare Print and Fax Drivers Disc into the media drive.
2. Click Management Services & Tools > Install Font Management Utility. The installation 

wizard opens. Click Next.
3. Select Repair. Click Next.
4. Click Install.
5. Click Finish to exit the wizard.
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5Xerox Desktop 
Scanning

The Xerox Scan Utility provides a way for you to control and manage image files scanned to 
your computer. Tasks that you can do with it include creating scanning templates, viewing 
scanned images, and deleting or copying image files. The Xerox Scan Utility can be installed 
with the scanning driver. There are two drivers available for desktop scanning:

• The Xerox WIA (Windows Image Acquisition) driver for Microsoft Windows provides you 
with a method to quickly scan simple jobs at your machine and retrieve the images at your 
PC desktop. 

• TWAIN is an industry standard for applications that interface with scanning devices. The 
TWAIN driver for Microsoft Windows XP/ Vista / Windows 7 provides scanning from your 
machine to applications that are compliant with the TWAIN standard. 

What’s in this chapter:
• Installation 5-2
• Xerox Desktop Scanning 5-1
• Managing Scan Templates 5-8
• Managing Folders and Email Profiles 5-11
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Installation

Installation Requirements

The following are required for installing the WIA or TWAIN drivers: 

• WIA Driver: The workstation must be running the Microsoft Windows XP, Vista, or Windows 
7 operating system. 

• TWAIN Driver: The workstation must be running the Microsoft Windows XP, Vista, or 
Windows 7 operating system. 

• You must possess Administrator rights on the workstation to install the driver. 
• Domain and local user accounts are supported. 

Note
Some older WorkCentres do not support domain accounts. 

• The workstation must have TCP/IP enabled. 
• Simple File Sharing must be disabled on the workstation to allow for proper device 

authentication. 
• Your machine must be connected, configured, and functioning as a network scanner with 

TCP/IP and HTTP enabled. 
• Your machine must be configured with the SNMP GET community string set to "public" or 

the driver will not detect the device properly. 
• For machines that support the Scan Template Management Service, you must enable this 

service on the device. SSL must be enabled on the device prior to enabling the Scan 
Template Management Service. 

Driver Installation
Note
Windows XP Professional Service Pack 2 has Windows Firewall turned on by default, or your 
site may have Windows Firewall enabled for security reasons. If Windows Firewall is 
enabled, you must set up Exceptions for print and file sharing to ensure that scanning with 
the driver works properly. 

This section covers installation of both the WIA and TWAIN drivers.

Note
During installation of the printer driver, you can select that the TWAIN driver and the Xerox 
Scan Utility software be installed.

Obtaining the Installation Files

The scan driver is available on the Print and Fax Drivers Disc provided with your Xerox product. It 
is also available on the Internet from www.xerox.com/drivers

Installing the Driver

If the driver is not installed automatically upon download, follow the steps below. 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&PgName=driver&Language=english
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To install the driver:
1. Open the Windows Control Panel. 

• For Windows XP Category view, choose Printers and Other Hardware. 
• For Windows XP Classic view, continue with step 2. 
• For Windows Vista / Windows 7 Control Panel Home, choose Hardware and Sound.
• For Windows Vista Classic view, continue with step 2.

2. Open Scanners and Cameras: 
• For Windows XP, open Scanners and Cameras and then click Add an imaging device.
• For Windows Vista, open Scanners and Cameras and then click Add Device. If the 

User Account Control dialog appears, click Continue.
• For Windows 7, in the Search Control Panel text box in the top right corner of the 

window, type Scanner. From the list that appears, in the Devices and Printers area, 
click View scanners and cameras. Click Add Device.

3. The Scanner and Camera Installation Wizard opens. Click Next. 
4. Click Have Disk and browse to the Windows 2K XP 03 Vista Scan folder, which is the 

location of the Windows Scan installation files. 
5. Open the 32-Bit folder, or the x64_AMD folder if your machine has an AMD processor, the 

English folder, and then click the .inf for your printer model. Click Open and OK.

6. Select either the TWAIN or WIA WorkCentre/Pro Scanner from the model list. Click Next. 

Note
Installing the TWAIN driver and the WIA driver on the same system can lead to unexpected 
results when using the Xerox Scan Utility. If both drivers are installed, templates created for 
the Xerox Scan Utility will send all jobs to the last driver installed. 

To work around this, use the Property page of each driver to create driver-specific 
templates. Using the driver’s Property page causes a _WIA or _TWAIN prefix to be added 
to the template name. This allows you to select driver specific templates when scanning. 
For more information, see Creating a Driver Specific Template on page 3-2.

7. Accept the default scanner name or enter a new name. Click Next. 
8. Click Finish. 
9. If a Security window appears, continue with the installation.
10. For Windows XP, the Hardware Update Wizard opens. Click Next. For Vista/Windows 7 the 

Xerox Settings window opens. 
11. Type the Host Name or IP Address of the desired scanner. If you do not identify a specific 

scanner at this time, you can select one on the Administrator Options tab in driver 
properties. Click Confirm. 

12. For Windows XP, if prompted, select Yes to disable Simple File Sharing. 
13. Click Next, and then click Finish to complete the installation. 
14. If notified to do so, reboot your computer to finish the installation. 

Configuring the Driver

Once you install the driver, either WIA or TWAIN, you must establish your user profile. You 
should be logged onto the computer with your personal Windows user account when you 
establish your profile. Common names such as Administrator or Guest cannot be used. 
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To set your profile and access driver properties:
1. Open the Windows Control Panel. 

• For Windows XP Category view, choose Printers and Other Hardware. 
• For Windows XP Classic view, continue with step 2. 
• For Windows Vista / Windows 7 Control Panel Home, choose Hardware and Sound.
• For Windows Vista Classic view, continue with step 2.

2. Open Scanners and Cameras. 
3. Right-click the scanning icon for the WorkCentre and choose Properties. 
4. Select the User Settings tab. This tab displays the default name for your scan template. A 

scan template is automatically created on the device and is named based on your Windows 
logon name concatenated with the PC name, and an optionally defined suffix. Any existing 
templates of the same name will be overwritten. 

Note
On some devices, the template name begins with an "@" symbol. 

Optional Suffix: If you would like an identifying suffix added to the template name, such 
as your initials, type it in the Optional Template Suffix field. 

5. Select the Scan Options tab and select default settings for your scan template. Any of 
these settings can be overridden directly at the WorkCentre. 
• Output Color: Select whether you want scanned documents saved in color or black and 

white. 
• Document Format: Select the file format in which your scanned documents should be 

saved. 

JPG: A graphic format ideal for complex pictures or photographs. Each document 
page becomes a separate JPG image. (Color scanners only.) 

TIFF: A file format for bitmap images; simulates grayscale shading. Each 
document page becomes a separate TIFF image. 

Multi-Page TIFF: TIFF file output in which all pages of a document are scanned 
into a single file. 

PDF: A universal file format that preserves all fonts, formatting, graphics, and color 
in a source document regardless of the application and platform used to create it. 
All pages in the document are saved in a single file. 

• Sides to scan: Select whether your original document is one-sided or two-sided. 
• Resolution: The resolution setting affects the amount of detail reproduced on scanned 

images. 
• Original Size: When scanning a document you can specify a particular scan size. This 

enables you to scan only a specific portion of a document page. 
6. If a device was not selected during the installation of the driver, the device host name or IP 

address can be set using the Administrator Options tab. 

Note
Note that you can only change the host name if one was not specified during the 
installation. Once a valid host name is entered, changes are not permitted. 

Enter the host name or the IP address of the device you want to configure. Click Apply or 
OK when finished. All templates created from that PC will be updated and configured to 
work with the new device. 
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Scanning

Overview

To scan using the driver:
1. Your PC must be turned on and you must be logged on using the same user account you 

used when you created your user profile. 
2. At the device, select All Services > Network Scanning, then select the template. 
3. If prompted at the printer touch screen, enter the user name and password for your 

Windows account. 
4. Import the scanned image into an application using an import or insert option.

Using the Xerox Scan Utility to Retrieve Images

Use the Scan to Email or Copy to Folder tabs in the Xerox Scan Utility to view and retrieve 
scanned images. You can save the images to a folder or include the images as attachments to 
email messages.

Scanning to Email

When sending scanned images as attachments to email, you can use an email profile that has 
been saved with specific settings, or you can attach scanned images to an email and select new 
settings without using a saved profile.

Note
The supported Email clients are Microsoft Outlook and Outlook Express

See the Xerox Scan Utility online help for complete instructions on how to scan to email.

Copying to a Folder

When copying scanned images to a folder, you can use a folder profile that has been saved with 
specific settings, or you can send scanned images to a folder and select new settings without 
using a saved profile.

See the Xerox Scan Utility online help for complete instructions on how to copy scanned images 
to a folder.

Importing Images into an Application

Images scanned to your computer can be imported into applications on your computer.

Note
The instructions below offer a method of importing images into a Windows application. 
The exact method depends on the application software. Check the instructions in the 
application for additional information on importing images via TWAIN.
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Importing Scanned Images into a Windows Application (TWAIN)

To import images into an application:
1. Open the file in which you want to place the image.
2. Select the application’s menu item to acquire the image. For example, if you are using Word 

to place an image in a document:
a. Select Insert. 
b. Select Picture. 
c. Select From Scanner or Camera. 
d. Select the scanner, and then click the Custom Insert button.
The window displays thumbnails of the images in the folder. The date and time that the 
image was scanned appears below each thumbnail. 

• If you move your mouse over the thumbnail, a pop-up message displays information 
including the resolution and size of the image file.

• If you recently scanned an image and do not see it displayed, click the Refresh button.
3. Select the image you want to import. Some applications allow you to import multiple 

images: 
• To select more than one image, hold down the Ctrl key on your keyboard as you select 

each image. 
• To import all of the images in the folder, select the Edit menu, and then select 

Select All.
4. Click the Retrieve button. A copy of the image is transferred to the location in your 

application. If you want to delete the images you selected, click the Delete button. 

Note
For more information, click the Help button to view online help.

Using the WIA Image Manager in a Windows Application

You can import images that you scanned from the product to your computer into an application 
using the WIA Image Manager on Windows XP, Vista, and Windows 7. 

Note
The instructions below offer a method of importing images into a Windows application. 
The exact method depends on the application software. Check the instructions in the 
application for additional information on importing images and in the WIA Image 
Manager help.

To import scanned images into an application:
1. Open the file in which you want to place the image.
2. Select the application’s menu item to acquire the image. For example, if you are using 

Microsoft Word to place an image in a document:
a. Select Insert. 
b. Select Picture. 
c. Select From Scanner or Camera. 
d. Select the scanner, and then click the OK button.

3. In the Get Pictures from WIA window, open the folder to view thumbnails of the images. 
The filename appears below each thumbnail.

4. To see details of an image file:
e. Select the image.
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f. Click View picture information. The Properties dialog box displays information about 
the file size and the date and time that the image was scanned.

g. Click the OK button to close the dialog box.
5. Select the image you want to import. Some applications enable you to import multiple 

images: 
• To select more than one image, hold down the Ctrl key on your keyboard as you select 

each image. 
• To import all of the images in the folder, select the Edit menu, and then select 

Select All.
6. Click the Get Pictures button.

A copy of the image is transferred to the location selected in your application.

Note
If you want to delete the images you selected, click the Delete button.

Deleting Image Files from the Xerox Scan Utility

Scanned images displayed in the Xerox Scan Utility are stored on your computer’s hard drive.

To delete scanned images that are no longer needed from the Xerox Scan Utility:
1. Access the Xerox Scan Utility on your computer:

Right-click the Xerox Scan Utility icon on the taskbar, and then select Xerox Scan Utility. If 
the icon does not appear in the taskbar, click Start, select Programs, select Xerox Office 
Printing, select Scanning, and then select Xerox Scan Utility.

2. Select the Scan to Email or Copy to Folder tab.
3. Select the images you want to delete.
4. Click the Delete Scanned Image button.
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Managing Scan Templates
You can create scan templates that contain specific settings, such as file type, resolution, and 
original size. You can choose to retain thumbnail images in the Xerox Scan Utility, or you can 
select a folder destination, so that when images are scanned, they are automatically copied 
into a designated folder.

To set or change the system’s date and time, use the Control Panel or CentreWare IS.

Creating a Driver Specific Template

To create either a TWAIN or WIA driver template:

Note
For Windows XP, select Classic Look so that the procedure steps match the steps below. To 
select Classic Look, click Start, click Control Panel, and then click Taskbar and Start Menu. 
Select the Start Menu tab, and then select the Classic Start menu. Click OK.

1. Open the Windows Control Panel.
2. Open Scanners and Cameras.
3. Right-click either the TWAIN scanner or the WIA scanner, and then select Properties. The 

driver’s Properties window opens.
4. Click the Scan Options tab, and then set the desired scan settings.
5. Click OK to save the template.

Your template is ready to use.
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Using the Xerox Scan Utility to Manage Templates

The Xerox Scan Utility enables you to control and manage image files scanned to your 
computer. You can also create several templates to use when scanning images to your 
computer. 

Creating a Template with an Image View Setting

To create a new Xerox Scan Utility template or edit an existing template with the option to 
retain thumbnail images in the Scan to Email or Copy to Folder tabs:
1. Access the Xerox Scan Utility on your computer:

Right-click the Xerox Scan Utility icon on the taskbar, and then select Xerox Scan Utility. If 
the icon does not appear in the taskbar, click Start, select Programs, select Xerox Office 
Printing, select Scanning, and then select Xerox Scan Utility.

2. Select the Scan Settings tab, and then select the settings you want to use with the 
template: Color, Black and White, Original Size, Resolution, Original Type, File Format, 
and Sides to Scan.

3. Select the Preview image in Xerox Scan Utility option to view the scanned image in both 
the Scan to Email or Copy to Folder tabs. From these tabs you can select the appropriate 
folder or email profile settings to use with your scanned images. 

4. Select one of the following options:
• To create a new template for the settings you select, enter the name for the new 

template in the Saved Templates Settings field.
• To edit an existing template with the settings you selected, select a template from the 

list displayed in the Saved Templates Settings drop-down list.
5. Click the Save button to save the settings for the new or revised template.

Creating a Template to Scan Images Directly to a Folder

To create a template that places scanned images in a specific folder destination:
1. Access the Xerox Scan Utility on your computer:

Right-click the Xerox Scan Utility icon on the taskbar, and then select Xerox Scan Utility. If 
the icon does not appear in the taskbar, click Start, select Programs, select Xerox Office 
Printing, select Scanning, and then select Xerox Scan Utility.

2. Select the Scan Settings tab, and then select the settings you want to use with the 
template: Color, Black and White, Original Size, Resolution, Original Type, File Format, 
and Sides to Scan.

3. Select the Send image directly to folder option to send the scanned images directly to a 
designated folder without first viewing the images. Enter information in the following 
fields:
a. To create a unique file name for the scanned images, enter a file name in the Base File 

Name field. The images are saved with the date and time each image was scanned 
added to the name. 

b. Enter the folder path where you want to save the file in the Save To field, or click the 
Browse button to locate the folder.
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c. Select one of the following options:
• Leave the Save a copy in Xerox Scan Utility option checked. This enables 

thumbnail views of the scanned images to remain in the Copy to Folder or Scan 
to Email tabs. This is the default setting.

• Remove the check mark in the Save a copy in Xerox Scan Utility option. This 
deletes thumbnail views of the scanned images.

4. Select one of the following options:
• To create a new template for the settings you selected: Enter the name for the new 

template in the Saved Templates Settings field.
• To edit an existing template with the settings you selected: Select a template from the 

list displayed in the Saved Templates Settings drop-down list.
5. Click the Save button to save the settings for the new or revised template.

See also: 
Creating Unique Image File Names on page 5-10

Creating Unique Image File Names

When each image is scanned, it is saved with a default file name indicating the date and time 
the image was scanned. The file name displays the format yyyy-mm-day_hh.mm.ss.xxx 
representing year-month-date_hour.minute.second.file type extension. 

For example, the filename 2008-07-01_13-45-15.pdf indicates that the image was scanned on 
July 1, 2008, at 1:45:15 PM and is a PDF file.

When you assign a new name to scanned images, the images display the new name with the 
date and time each image was scanned added to the name. See the following two examples:

• If you enter the name report as the new name for an image that was scanned at 1:45:15 
PM on July 1, 2008, the new image name becomes report_2008-07-01_13-45-15.xxx. 

• If you enter the name report for several images that were scanned at varying times on 
July 1, 2007, the new names become report_2008-07-01_13-45-15.xxx, 
report_2008-07-01_13-45-25.xxx, and report_2008-07-01_13-47-32.xxx. The date and 
time information is unique for all scanned images.

Deleting Templates

To delete a template:
1. Access the Xerox Scan Utility on your computer:

Right-click the Xerox Scan Utility icon on the taskbar, and then select Xerox Scan Utility. If 
the icon does not appear in the taskbar, click Start, select Programs, select Xerox Office 
Printing, select Scanning, and then select Xerox Scan Utility.

2. Select the Scan Settings tab.
3. Select the template you want to delete in the Saved Template Settings drop-down list.
4. Click the Delete button.
5. When prompted, confirm that you want to delete the template.
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Managing Folders and Email Profiles
With the Xerox Scan Utility, you can create profiles to reuse when sending scanned images as 
email attachments or when copying scanned images to specific folders. Profiles eliminate the 
need for re-entering the same email or folder destination information. 

Creating or Editing Email Profiles

To create or revise an email profile:
1. Access the Xerox Scan Utility on your computer:

Right-click the Xerox Scan Utility icon on the taskbar, and then select Xerox Scan Utility. If 
the icon does not appear in the taskbar, click Start, select Programs, select Xerox Office 
Printing, select Scanning, and then select Xerox Scan Utility.

2. Select the Scan to Email tab.
3. Select one of the following options:

• To create a new profile: Enter the name for the new profile in the Email Profiles field.
• To edit an existing profile: Select a profile from the list displayed in the Email Profiles 

drop-down list.
4. To create a unique name for one or more of the scanned images in the thumbnail view:

a. Select the images, and then enter a file name in the Base Attachment Name field.
b. Enter the appropriate information in the To, CC, Subject, and Message fields.

5. Click the Save button to save the settings for the new or revised profile.

Note
When you enter a new file name for images in the Base Attachment Name field, and the 
profile is saved, the new file name displays the name you entered and the unique date and 
time each image was scanned.

Deleting Email Profiles

To delete an email profile:
1. Access the Xerox Scan Utility on your computer:

• Right-click the Xerox Scan Utility icon on the taskbar, and then select Xerox Scan 
Utility. If the icon does not appear in the taskbar, click Start, select Programs, select 
Xerox Office Printing, select Scanning, and then select Xerox Scan Utility.

2. Select the Scan to Email tab.
3. Select the profile you want to delete in the Email Profiles drop-down list.
4. Click the Delete button.
5. When prompted, confirm that you want to delete the profile.
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Creating or Editing Folder Profiles

To create or revise a folder profile:
1. Access the Xerox Scan Utility on your computer:

Right-click the Xerox Scan Utility icon on the taskbar, and then select Xerox Scan Utility. If 
the icon does not appear in the taskbar, click Start, select Programs, select Xerox Office 
Printing, select Scanning, and then select Xerox Scan Utility.

2. Select the Copy to Folder tab.
3. Select one of the following options:

• To create a new profile: Enter the name for the new profile in the Folder Profiles field.
• To edit an existing profile: Select a profile from the list displayed in the Folder Profiles 

drop-down list.
4. To create a unique name for one or more of the scanned images in the thumbnail view:

a. Select the images, and then enter a file name in the Base File Name field. 
b. Enter the folder path where you want to save the file in the Save To field, or click the 

Browse button to locate the folder.

5. Click the Save button to save the settings for a new or revised profile. 

Note
When you enter a new file name for images in the Base File Name field, and the profile is 
saved, the new file name displays the name you entered and the unique date and time 
each image was scanned

Deleting Folder Profiles

To delete a folder profile:
1. Access the Xerox Scan Utility on your computer:

Right-click the Xerox Scan Utility icon on the taskbar, and then select Xerox Scan Utility. If 
the icon does not appear in the taskbar, click Start, select Programs, select Xerox Office 
Printing, select Scanning, and then select Xerox Scan Utility.

2. Select the Copy to Folder tab.
3. Select the profile you want to delete in the Folder Profiles drop-down list.
4. Click the Delete button.
5. When prompted, confirm that you want to delete the profile.
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6Problem Solving

Application, device, and network errors can occur in a variety of printing situations. In many 
cases, simply restarting the application, the workstation, or the printer will resolve the problem. 
This chapter includes some of the common problems and Frequently Asked Questions that 
pertain to CentreWare Printer Drivers and printing to your Xerox system.

What’s in this chapter:
• Troubleshooting a Problem 6-2
• Common Issues 6-2
• Frequently Asked Questions 6-5
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Troubleshooting a Problem
When a problem persists, document the error messages and gather information to define the 
problem. The following problem-solving procedures are recommended:

• Accurately define the problem. When, where, and how does the problem occur?
• Reproduce the problem. Can the problem be reproduced consistently or is it an intermittent 

problem?
• Ask other users if they have encountered the problem, and keep a log to track problem 

occurrences. 
• Examine the data for trends and the common attributes that may be related to the 

problem. For example, does the problem occur only with a specific printer or on a specific 
workstation/network configuration?

• Review the product documentation, including the README files and problem solving topics, 
to see if any similar problems are documented. 

If a cause and solution to the problem cannot be identified, call the Xerox Welcome Center to 
report the error information. Provide the support representative with the documentation that 
you have gathered to define the problem.

Common Issues
This section discusses some common application and printer driver functionality issues.

Adobe Acrobat Printing

All versions of Adobe Acrobat have exhibited various forms of distorted output when printing 
from a PCL driver. Stray lines, random character spacing, and data loss have been observed on 
various PDF documents. A CentreWare PostScript driver is recommended for printing Acrobat 
PDF files.

Acrobat Reader and Booklet Layout

Random PostScript errors can be generated at the printer when using a PostScript driver and 
Acrobat Reader 7, or newer, while selecting booklet mode. Font and Resource handling within 
Acrobat Reader must be changed from the default setting of Send by Range to the Send for 
Each Page setting. Make this change by following the path File > Print > Advanced > Font and 
Resource Policy. After changing the selection to Send for Each Page, resubmit the job to the 
printer.

Booklet and Multiple-Up (N-Up) Printing

Some applications do not support booklet or N-up printing.  

• Microsoft Word mail merge documents cannot be printed as booklets or N-up.
• You may need to reset the Booklet or N-Up settings before you save your documents. Some 

applications, such as Microsoft Word 97, will save the scaling setting with the document. 
When the document is reopened later, the text and graphics may print in a reduced format 
unless you reset the N-Pages Up option on the printer driver Layout/Watermark tab to 1-
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Up prior to printing. It is generally best to reset this option to 1-Up before you save and 
close your documents.

• N-up and booklet printing features may not work properly with Corel Draw version 8.
• Use PCL Raster mode to print large N-Up/Booklet documents that do not print properly in 

Vector mode.

Euro Symbol

The Xerox Euro font family was created to support the imaging of the Euro currency symbol 
with fonts that do not yet support this character. The Xerox Euro font family consists of the Euro 
symbol in various styles and weights designed to work in conjunction with the most popular 
font styles. Many styles include a symbol at numeric width, which conforms to the standard 
design rules of the Euro symbol, as well as a designer version of the character, created to more 
closely resemble the original font. To use the symbol, set the font selection to Xerox Euro and 
type the keystroke that corresponds to the type style you are using. 

• Xerox Euro Fonts are provided on the CentreWare Print and Fax Drivers Disc within the 
...\Windows\Fonts folder.

• Additional information and font installation instructions are available through the Internet 
on the Xerox Web site at www.xerox.com. 

• If the fonts on your printer are not updated to include the Euro, a box will be printed 
instead of the Euro symbol. A workaround for this problem is to send Euro fonts to the 
printer as bitmapped images.

• For PCL drivers, select the Always Send to Printer option in the CentreWare PCL driver when 
printing the Euro symbol. If problems persist when printing the Euro symbol, select the 
Send as Graphics option.

PDF Printing
When printing a PDF, sending a large file may result in the printing of print limit check error 
sheets or only a banner sheet. If this occurs, print the PDF file using the PostScript printer 
driver or try printing the PDF file using LPR. 

Microsoft Applications

Excel
• To change the job type options for any individual document, you must set the job type 

from within Microsoft Excel (Page Setup dialog). Job type changes for an individual 
document will not take effect if you invoke the CentreWare printer driver from the Printers 
folder.

• Excel will generate multiple print jobs instead of multiple copies of a single document. This 
behavior can result in performance degradation, as well as inoperability of features, such as 
Sample Set, which depend on multiple set printing. In Excel, deselect the Collate option. 
This allows the driver settings to collate correctly. 

• Excel may have occasional problems with documents that contain a mix of portrait and 
landscape pages. Selecting a different printer driver, then reselecting the original printer 
driver may help to resolve this problem.

PowerPoint

The Microsoft PowerPoint feature that optimizes black and white printing will produce 
undesired results when Raster output is selected as the Graphics Mode in the CentreWare PCL 

http://www.xerox.com
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printer driver. Do not choose the black and white option in PowerPoint if Raster output is 
required.

PCL Printer Driver

Print Colored Text in Black

This feature may not work with some applications, or you may have to select the option from 
within the application if it is supported. Certain applications, such as WordPerfect and MS 
Publisher, always print text as graphics or may default to the graphics mode when memory is 
low or when the text is very complex. When these circumstances occur, the Print Colored Text 
in Black feature in the CentreWare PCL printer drivers will not work.

Sample Set Not Supported in FrameMaker

Some applications generate print data that is intended for page printers rather than document 
printers, like the WorkCentre Pro and WorkCentre series. When the print data is sent in this 
format, both the WorkCentre Pro and the WorkCentre will print the first set of a Sample Set job, 
but the remaining sets of the document will be discarded. There is no known workaround for 
this problem.

Watermarks

The Watermark preview image in the printer drivers may not provide an exact replica of the 
printed watermark under all conditions. This is primarily due to font and/or resolution 
differences between the display monitor and the printer. Using equivalent TrueType fonts 
instead of printer resident fonts will help minimize the differences.

With some applications, the CentreWare PCL drivers may appear to print watermarks in the 
foreground even when the background printing option is selected in the driver. This is due to the 
different methods that applications use to send data to the printer. 

WordPerfect
• If you encounter problems stapling multiple jobs as separate documents with WordPerfect 

8.x, install the service pack available for WordPerfect at www.corel.com to correct the issue. 
• Sample Set job types will not work with WordPerfect 8.x for Windows.
• B4 JIS, B4 ISO, B6, and A6 paper sizes do not print with WordPerfect 8.x for Windows.  
• The scaling option in WordPerfect versions 7, 8, and 9 will override the Reduce/Enlarge 

option in the CentreWare drivers. Use the scaling option in the Print/Customize property 
sheet to adjust scaling rather than the CentreWare printer driver Reduce/Enlarge option.

• With WordPerfect 6.1, the Playbill font may not print correctly when the Use Printer Fonts 
option is selected because the printer does not support the Playbill font.
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Frequently Asked Questions
How do I obtain printer drivers?

Printer drivers are available on the CentreWare Print and Fax Drivers Disc or from the Xerox 
Web site at www.xerox.com. See “Obtaining CentreWare Drivers” on page 1-3 for more 
information.

How do I determine what printer driver is needed?
The following information is necessary to determine the correct printer driver:

• Model of your Xerox system
• Operating system environment, for example, Windows XP 
• Type of printer driver, for example, PostScript or PCL

http://www.xerox.com
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